State Bank of India
Central Recruitment & Promotion Department
Corporate Centre, Mumbai
Phone: 022-22820427, Email: crpd@sbi.co.in

RECRUITMENT OF SPECIALIST CADRE OFFICERS IN SBI ON REGULAR BASIS
ADVERTISEMENT NO: CRPD/SC0/2022-23/10

ONLINE REGISTRATION OF APPLICATION & PAYMENT OF FEES: FROM 27.05.2022 TO 16.06.2022

State Bank of India invites Online application from Indian citizens for appointment to the following Specialist Cadre Officers posts on

regular basis. Candidates are requested to apply Online through the link given on Bank’s website
https://bank.sbi/careers or https://www.sbi.co.in/careers
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. The process of Registration is complete only when fee is deposited with the Bank through Online mode on or before the last date for

payment of fee.

Before applying, candidates are requested to ensure that they fulfil the eligibility criteria for the post as on the date of eligibility.
Candidates are required to upload all required documents (brief resume, ID proof, age proof, caste certificate, PWD Certificate (if
applicable), educational qualification, experience etc. failing which their application/candidature will not be considered for
shortlisting/ interview.

Short listing will be provisional without verification of documents. Candidature will be subject to verification of all details/ documents with
the original when a candidate reports for interview (if called).

In case a candidate is called for interview and is found not satisfying the eligibility criteria (Age, Educational Qualification and Experience
etc.) he/ she will neither be allowed to appear for the interview nor be entitled for reimbursement of any travelling expenses.

Candidates are advised to check Bank’s website https://bank.sbi/careers or https://www.sbi.co.in/careers regularly for details and
updates (including the list of shortlisted/ selected candidates). The Call (letter/ advice), where required, will be sent by e-mail only (no
hard copy will be sent).

ALL REVISIONS/ CORRIGENDUM (IF ANY) WILL BE HOSTED ON THE BANK’S WEBSITE ONLY.

In case more than one candidate scores same marks as cut-off marks in the final merit list (common marks at cut-off point), such
candidates will be ranked in the merit according to their age in descending order.

Hard copy of application & other documents not to be sent to this office.

A. DETAILS OF POST/VACANCY/ GRADE/SCALE/ AGE /PLACE OF POSTING/ /SELECTION PROCESS:

Vacancy
Sr. Maximum | Place of | Selection
Name of Post OBC Grade/Scale o
No. Total UR | EWS sc | sT!|pPwD Age posting Procedure
Vacancy (VI* (As on
Current | Backlog 31.03.2022)
1 | Risk Specialist- 5 4 i i 1 | 1 MMGS-I|
Sector
o) Risk Specialist- 2 1 i i 1 i i 1
Sector
3 Risk Specialist- 1 1 i i i i i 1 Shortlisting-
' Credit 40 Years Mumbai cum-
4 Risk Specialist- 1 1 i ) i i ) 1 MMGS-III interaction
' Climate Risk
Risk Specialist-
5. IND AS 3 2 - - 1 - - 1
Risk Specialist-
6. Market Risk 2 2 i ] i S| 1

ABBREVIATION: UR- Unreserved, EWS-Economically Weaker Section, OBC-Other Backward Class, SC-Scheduled Caste, ST-Scheduled

Tribe, PWD-Persons with Disabilities VI-Visually Impaired, MMGS- Middle Management Grade Scale
* Reservation is horizontal and is included in the vacancy of the respective parent category.

# THE BANK RESERVES THE RIGHT TO POST OR TRANSFER THE SERVICES TO ANY OF THE OFFICES OF STATE BANK OF INDIA IN INDIA, OR TO DEPUTE TO ANY
OF ITS ASSOCIATES/SUBSIDIARIES OR ANY OTHER ORGANIZATION DEPENDING UPON THE EXIGENCIES OF SERVICE.

IMPORTANT POINTS:

i
il
iii.
iv.
V.
Vi.
Vii.
Viii.

Candidates applying for post sr. nos. 1 & 2 can apply for both posts.

The number of vacancies including reserved vacancies mentioned above is provisional and may vary according to the actual requirement
of the Bank.

Candidate must possess the relevant full-time experience as on specified date.

The relevant experience certificate from employer must contain specifically that the candidate had experience in that related field as
required.

Candidate belonging to reserved category including Person with Disabilities for whom no reservation has been mentioned are free to
apply for vacancies announced for General category provided they fulfil all the eligibility criteria applicable to General category.

The reservation under various categories will be as per prevailing Government Guidelines.

PWD candidate should produce a certificate issued by a competent authority as per the Government of India Guidelines.

Relaxation in age is as per Govt. of India Guidelines.
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B. DETAILS OF BASIC QUALIFICATION, PREFERRED QUALIFICATION, EXPERIENCE & SPECIFIC SKILLS REQUIRED:

I. For Post Nos. 1 & 2:

PREFERRED SPECIFIC SKILLS
BASIC QUALIFICATIONS QUALIFICATIONS EXPERIENCE AS ON 31/03/2022 DESIRED
i. Chartered Accountant (CA), or » Financial Risk | Minimum 2 years for post no. 1 and > Excellent
Manager (FRM) | Minimum 4 years for post no. 2 post Communication Skills
ii. CFA, or by GARP,or qualification experience in Financial (verbal as well as
institutions/ Rating Agencies/ Brokerage written)
iii. MBA/PGDM (Finance /Data » Professional Firms/Large Trading House with domain »> Problem Solving
Analytics/Business Analytics) or Risk Managers | knowledge across sector/industry,experience, Attitude
its equivalent as full-time course by PRMIA in primary/secondary research, experience in » Analytical Thinking
from recognised institute, or risk modelling, data analysis, report writing, » Experience in working
etc.,in any of the following sectors: on applications like
iv. M.Sc. (Statistics) python, R,
a. Power/renewable energy, SPSS,SAS,etc.
b. Real Estate, » Proficiency in MS
c. Automobiles & Auto Components Office  applications,
d. Textiles, especially in MS
e. Food Processing, Excel.
f. Precious Metals, Bullion, Gems &
Jewellery,etc.,
g. Service Industries, like Telecom, IT,
Hospitality, Hospitals, Education, etc.
Il. For Post No.3:
PREFERRED EXPERIENCE AS ON SPECIFIC SKILLS
BASIC QUALIFICATIONS QUALIFICATIONS 31/03/2022 DESIRED
i. Chartered Accountant (CA), or » Financial Risk | Minimum 4 years post qualification experience » Excellent
Manager (FRM) | in Risk Related work in Credit Risk and risk Communication Skills
ii. CFA, or by GARP,or modelling in Financial Institutions /Rating (verbal as well as
Agencies/Brokerage firms. written)
iii. MBA/PGDM (Finance /Data » Professional » Problem Solving
Analytics/Business Analytics) or Risk Managers Attitude
its equivalent as full-time course by PRMIA » Analytical Thinking
from recognised institute, or » Experience in working
on applications like
iv. M.Sc. (Statistics) python, R,
SPSS,SAS,etc.
» Proficiency in MS
Office  applications,
especially in MS
Excel.
[ll. For Post No.4:
PREFERRED
BASIC QUALIFICATIONS QUALIFICATIONS EXPERIENCE AS ON 31/03/2022 SPECIFIC SKILLS DESIRED
Minimum Post Graduate/Master’s » Financial Risk | Minimum 4 years post qualification » Excellent Communication
degree in Environmental Manager (FRM) | experience in Risk Related work in Skills (verbal as well as
Management or Environmental by GARP, or Credit Risk and risk modelling in written)
Sciences or Climate Change or Financial Institutions /Rating » Problem Solving Attitude
Climate Finance or Disaster » Professional Agencies/Brokerage firms. » Analytical Thinking
Management or Natural Resource Risk Managers » Experience in working on
Management or Geography or by PRMIA, or applications like python, R,
Urban Planning or Agriculture SPSS,SAS,etc.
Sciences from a recognised » Sustainability » Proficiency in MS Office
university with first class or and Climate applications, especially in MS
equivalent with a consistently Risk by GARP Excel.
good academic record throughout.
IV. For Post No.5:
PREFERRED
BASIC QUALIFICATIONS QUALIFICATIONS EXPERIENCE AS ON 31/03/2022 SPECIFIC SKILLS DESIRED
i. Chartered Accountant (CA), or » Financial Risk | Minimum 4 years post qualification » Excellent Communication
Manager experience in Risk Related work in Skills (verbal as well as
ii. CFA, or (FRM) by | Credit Risk and risk modelling in written)
GARP,or Financial Institutions /Rating » Problem Solving Attitude
iii. MBA/PGDM (Finance /Data Agencies/Brokerage firms. » Analytical Thinking
Analytics/Business Analytics) or > Professional » Experience in working on
its equivalent as full-time course Risk Managers applications like python, R,
from recognised institute, or by PRMIA SPSS,SAS,etc.
» Proficiency in MS Office
iv. M.Sc. (Statistics) applications, especially in MS
Excel.




V. For Post No.6:

PREFERRED
BASIC QUALIFICATIONS QUALIFICATIONS EXPERIENCE AS ON 31/03/2022 SPECIFIC SKILLS DESIRED
i. Chartered Accountant (CA), or » Financial Risk | Minimum 4 years post qualification » Excellent Communication
Manager experience in Financial Skills (verbal as well as
ii. MBA/PGDM (Finance /Data (FRM) by | Institutions/Rating Agencies/Brokerage written)
Analytics/Business Analytics) or GARP, or Firms/Trading House with domain » Problem Solving Attitude
its equivalent as full-time course knowledge across Market Risk. » Analytical Thinking
from recognised institute, or > Professional » Experience in working on
Risk Managers applications like python, R,
iii. M.Sc. (Statistics) by PRMIA, or SPSS,SAS, etc.
» Proficiency in MS Office
» CFA applications, especially in
MS Excel.

C.DETAILS OF JOB PROFILE (DETAILED DESCRIPTION OF ROLE, RESPONSIBILITIES & FUNCTION) AND KEY RESPOSIBILITY AREA:

SR. NO. POST JOB PROFILE KRA
I._Industry Research and Large Account Reports:
% Conduct historical performance analysis quantitatively and
gualitatively (trends, disruptions, etc.)
1. Risk Specialist-Sector % Actively Monitor developments in the sector to update the
(MMGS-I1) financial model assumptions and update forward looking macro
sectoral views of the bank and key large accounts outlook. % Independently
%+ Ensure creation of reports within target TAT and with minimum tracking the
errors. industry & analysis
% Liaise with Sector Credit specialists within Credit Review of developments
department to discuss important sector level updates and
exchange feedback on key observations. % Variance in risk
exposure  versus
ii. Sectoral Coverage: policy limits
% Attend conferences, seminars, trade association, chambers of % Number of
commerce meetings related to the sector and network with breaches in
other bankers, equity research analysts, and industry leaders, adherence to
5 % Carry out primary research (site visits, client interactions, etc.) regulatory policies
' for key clients within the sector to generate ground level
Risk Specialist-Sector understanding of the sector to form forward looking macro views < Number of times
(MMGS-I11) on the sector and develop outlook on the key large accounts, there is a delay or
% Participate in the investor presentations, analysts earning calls error in risk reports.
and Annual General Meetings for the leading players in the
sector
% Closely monitor the business news along with public research
publications and reports/commentaries by brokerages, fund
houses and independent analysis to update sectoral and
company views in fast changing market.
“+ Monitoring the credit portfolio in terms of limits on concentration
in quality, geography, industry, product, maturity, and large
exposure aggregates
% Ensuring that adequate policies & systems are in place for . . .
3. ' ialist- it Ri identifying, measuring, mitigating, monitoring, and controlling of * Credlt_ Risk
Risk Specialist-Credit Risk l fying, g, gating, g9, g Modelling and
credit risk in respect of Bank’s credit validation
% To evolve Credit Risk Assessment (CRA)/scoring models for . ) . .
. % Variance in risk
various groups of borrowers exposure  Versus
% To carry out Risk Components viz. Probability of Default, Loss licy limit
Given Default (LGD), and Exposure At Default (EAD) - bo 'C)t/) Imits ;
+« To arrange for periodic review of credit risk related policies and * Number 0
. O . . . , breaches In
dissemination of information. To analyse the credit portfolio of
: ) ) . adherence to
the Bank on various defined parameters. To identify and assess .
. i . . regulatory policies
risk factors/concentrations and recommend remedial action & Number of times
4. . . . % To compute Credit Risk Premium (CRP) and advising the same iy there is a delay or
Risk Specialist-Climate to CPPD/Business Groups for deciding interest rates. i riek y
Risk % Model Development, Review of models, rating transition study error in risk reports
% IRB project (Data collection from operating units,conducting
workshops for Risk raters, coordinating with EDW for loading
data in RDM and capital computation)




% Defining significant increase in Credit Risk (SICR)
% Incorporating forward looking macro-economic factors in PD,
LGD, and EAD models o
% Calculation of PIT PD and lifetime PD for the entire loan ‘:‘ Bank RARO.C sk
portfolio % Variance Iin ris
% Long run average Loss Given Default for the entire loan Séﬁgjtljirrﬁits versus
. portfpllq . % Value of loans
% Monitoring of PD, LGD and EAD models on a quarterly basis.
¢ Validation of all the ab model structured and sold
5. Risk Specialist- IND AS « valication of a¥ In€ above Moaels, _— < Number of
redevelopment/recalibration of the models based on validation breaches in
results
¢ Incorporation of process note on ECL methodology for adherence o
) o regulatory policies
investments as per IND-AS and monitoring of ECL model on & Number of times
regular basis g )
% Defining, effective interest rate (EIR) and the process to be there_ls a delay or
) . . error in risk reports.
adopted for the investment in the valuation manual
% Testing of Hedge Effectiveness
% Market Risk Capital Charge
_ o _ % Valuation of rupee and foreign currency on balance sheet and
6. Risk Specialist-Market Risk off-balance sheets investments As applicable
% Fundamental review of trading book (FRTB), Minimum capital
requirements of market Risk
% Introduction of Standardised Approach- counter party risk

REMARKS: Job profile/KRAs mentioned above is illustrative. Roles/Job, in addition to above, may be assigned by the bank from time to time for
the above posts.

D. REMUNERATION:

GRADE PAY SCALE
MMGS-II Rs. (48170-1740/1-49910-1990/10-69810)
MMGS-III Rs. (63840-1990/5-73790-2220/2-78230)

The scale of pay applicable to respective grade are furnished above. The official will be eligible for DA, HRA, CCA,
PF, Contributory Pension Fund, LFC, Medical Facility, other perquisites etc. as per rules in force from time to time.

E. HOW TO APPLY: Candidates should have valid email ID which should be kept active till the declaration of result. It will help him/her in getting
call letter/Interview advices etc. by email.

GUIDELINES FOR FILLING ONLINE APPLICATION

GUIDELINES FOR PAYMENT OF FEES

Candidates will be required to register themselves online
through the link available on SBI website
https://bank.sbi/careers OR https://www.sbi.co.in/careers
and pay the application fee using Internet Banking/ Debit Card/
Credit Card etc.

Candidates should first scan their latest photograph and
signature. Online application will not be registered unless
candidate uploads his/ her photo and signature as specified on
the online registration page (under ‘How to Upload Document”).
Candidates should fill the application carefully. Once
application is filled-in completely, candidate should submit the
same. In the event of candidate not being able to fill the
application in one go, he can save the information already
entered. When the information/ application is saved, a
provisional registration number and password is generated by
the system and displayed on the screen. Candidate should
note down the registration number and password. They can
re-open the saved application using registration number and
password and edit the particulars, if needed. This facility of
editing the saved information will be available for three times
only. Once the application is filled completely, candidate should
submit the same and proceed for online payment of fee.

After registering online, the candidates are advised to take
a printout of the system generated online application
forms.

Vi.

Vil.

Application fees and Intimation Charges (Non-refundable) is
X750/- (XSeven Hundred Fifty only) for General/EWS/OBC
candidates and no fees/intimation charges for SC/ ST/ PWD
candidates.

After ensuring correctness of the particulars in the application
form, candidates are required to pay the fees through payment
gateway integrated with the application. No change/ edit in the
application will be allowed thereafter.

Fee payment will have to be made online through payment
gateway available thereat. The payment can be made by using
Debit Card/ Credit Card/ Internet Banking etc. by providing
information as asked on the screen. Transaction charges for
online payment, if any, will be borne by the candidates.

On successful completion of the transaction, e-receipt and
application form, bearing the date of submission by the
candidate, will be generated which should be printed and
retained by the candidate.

If the online payment of fee is not successfully completed in
first instance, please make fresh attempts to make online
payment.

A provision is there to reprint the e-Receipt and Application
form containing fee details, at later stage.

Application Fee once paid will NOT be refunded on any
account NOR can it be adjusted for any other examination
or selection in future.

F. CALL LETTER FOR INTERVIEW: INTIMATION/ CALL LETTER FOR INTERVIEW WILL BE SENT BY EMAIL OR WILL BE UPLOADED ON BANK'S WEBSITE. NO
HARD COPY WILL BE SENT.
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G. SELECTION PROCESS: The selection will be based on shortlisting and interview.

Shortlisting: Mere fulfilling minimum qualification and experience will not vest any right in candidate for being called for interview. The shortlisting
committee constituted by the Bank will decide the shortlisting parameters and thereafter, adequate number of candidates, as decided by the
Bank, will be shortlisted for interview. The decision of the Bank to call the candidates for the interview shall be final. No correspondence will be
entertained in this regard. The shortlisted candidates will be called for interview.

Interview: Interview will carry 100 marks. The qualifying marks in interview will be decided by the Bank. No correspondence will be entertained
in this regard.

Merit list: Merit list for selection will be prepared in descending order on the basis of scores obtained in interview only. In case more than one

candidate scores the cut-off marks (common marks at cut-off point), such candidates will be ranked according to their age in descending order,
in the merit list.

H. HOW TO UPLOAD DOCUMENTS:

a. Details of Document to be uploaded: d. Document file type/ size:
i. Brief Resume (PDF) i. All Documents must be in PDF
ii. 1D Proof (PDF) ii. Page size of the document to be A4
iii.  Proof of Date of Birth (PDF) iii. Size of the file should not be exceeding 500 kb.
iv.  PWD certification (if applicable) (PDF) Iv. In case of Document being scanned, please ensure it is saved
v. Educational Certificates: Relevant Mark-Sheets/ Degree as PDF and size not more than 500 kb as PDF. If the size of the
Certificate (PDF) file is more than 500 kb, then adjust the setting of the scanner
vi.  Experience certificates (PDF)/Driving Licence (Two-wheeler) such as the DPI resolution, no. of colors etc., during the process
(PDF) of scanning. Please ensure that Documents uploaded are clear
vii.  Form-16/Offer Letter/Latest Salary slip from current employer and readable.
(PDF)

vii.  NOC (If applicable) (PDF)
ix. Recent Photograph
X.  Signature

b. Photograph file type/ size: e. Guidelines for scanning of photograph/ signature/ documents:
i.  Photograph must be a recent passport style colour picture. i. Set the scanner resolution to a minimum of 200 dpi (dots per
ii.  Size of file should be between 20 kb - 50 kb and Dimensions inch)

200 x 230 pixels (preferred) ii. Set Colorto True Color

iii.  Make sure that the picture is in colour, taken against a light- lii. Crop the image in the scanner to the edge of the photograph/
coloured, preferably white, background. signature, then use the upload editor to crop the image to the

iv.  Look straight at the camera with a relaxed face final size (as specified above).

v. If the picture is taken on a sunny day, have the sun behind iv. The photo/ signature file should be JPG or JPEG format (i.e. file
you, or place yourself in the shade, so that you are not name should appear as: image01.jpg or image01.jpeq).
squinting and there are no harsh shadows v. Image dimensions can be checked by listing the folder/ files or

vi. If you have to use flash, ensure there's no "red-eye" moving the mouse over the file image icon.

vii.  If you wear glasses make sure that there are no reflections vi. Candidates using MS Windows/ MSOffice can easily obtain

and your eyes can be clearly seen. photo and signature in .jpeg format not exceeding 50 kb & 20 kb

viii.  Caps, hats and dark glasses are not acceptable. Religious respectively by using MS Paint or MSOffice Picture Manager.

headwear is allowed but it must not cover your face. Scanned photograph and signature in any format can be saved

ix. Ensure that the size of the scanned image is not more than in .jpg format by using ‘Save As’ option in the File menu. The file
50kb. If the size of the file is more than 50 kb, then adjust the size can be reduced below 50 kb (photograph) & 20 kb
settings of the scanner such as the DPI resolution, no. of (signature) by using crop and then resize option (Please see
colour etc., during the process of scanning. point (i) & (ii) above for the pixel size) in the ‘Image’ menu. Similar

options are available in another photo editor also.
vii. While filling in the Online Application Form the candidate will be
provided with a link to upload his/her photograph and signature

c. Signature file type/ size: f. Procedure for Uploading Document:
i.  The applicant has to sign on white paper with Black Ink pen. i. There will be separate links for uploading each document.
ii. The signature must be signed only by the applicant and not by ii. Click on the respective link "Upload"
any other person. ii. Browse & select the location where the JPG or JEPG, PDF, DOC
i. The signature will be used to put on the Call Letter and or DOCX file has been saved.
wherever necessary. iv. Select the file by clicking on it and Click the 'Upload' button.
iv.  Size of file should be between 10 kb - 20 kb and Dimensions| V- Click Preview to confirm the document is uploaded and
140 x 60 pixels (preferred). accessible properly before submitting the application. If the file
v. Ensure that the size of the scanned image is not more than 20 Zi_zelanddformat are not as prescribed, an error message will be
kb. isplaye
vi.  Signature in CAPITAL LETTERS shall NOT be accepted vi. Once uploaded/ submitted, the Documents uploaded cannot be
' ' edited/ changed.

vii. After uploading the photograph/ signature in the online
application form candidates should check that the images
are clear and have been uploaded correctly. In case the
photograph or signature is not prominently visible, the candidate
may edit his/ her application and re-upload his/ her photograph
or signature, prior to submitting the form. If the face in the
photograph or signature is wunclear the candidate’s
application may be rejected




I. GENERAL INFORMATION:

VI.

VILI.

VIIL.

Before applying for the post, the applicant should ensure that
he/ she fulfils the eligibility and other norms mentioned above
for that post as on the specified date and that the particulars
furnished by him/ her are correct in all respects.

Candidates belonging to reserved category including, for
whom no reservation has been mentioned, are free to apply
for vacancies announced for General category provided they
must fulfil all the eligibility conditions applicable to General
category.

IN CASE IT IS DETECTED AT ANY STAGE OF
RECRUITMENT THAT AN APPLICANT DOES NOT FULFIL
THE ELIGIBILITY NORMS AND/ OR THAT HE/ SHE HAS
FURNISHED ANY INCORRECT/ FALSE INFORMATION OR
HAS SUPPRESSED ANY MATERIAL FACT(S), HIS/ HER
CANDIDATURE WILL STAND CANCELLED. IF ANY OF
THESE SHORTCOMINGS IS/ ARE DETECTED EVEN
AFTER APPOINTMENT, HIS/ HER SERVICES ARE LIABLE
TO BE TERMINATED.

The applicant should ensure that the application is strictly in
accordance with the prescribed format and is properly and
completely filled.

Appointment of selected candidate is subject to his/ her being
declared medically fit as per the requirement of the Bank. Such
appointment will also be subject to the service and conduct
rules of the Bank for such post in the Bank, in force at the time
of joining the Bank.

Candidates are advised to keep their e-mail ID active for
receiving communication viz. call letters/ Interview date
advices etc.

The Bank takes no responsibility for any delay in receipt or
loss of any communication.

Candidates serving in Govt./ Quasi Govt. offices, Public Sector
undertakings including Nationalised Banks and Financial
Institutions are advised to submit ‘No Objection Certificate’
from their employer at the time of interview, failing which their
candidature may not be considered and travelling expenses, if
any, otherwise admissible, will not be paid.

In case of selection, candidates will be required to produce
proper discharge certificate from the employer at the time of
taking up the appointment.

Candidates are advised in their own interest to apply online
well before the closing date and not to wait till the last date to
avoid the possibility of disconnection / inability/ failure to log
on to the website on account of heavy load on internet or
website jam. SBI does not assume any responsibility for the
candidates not being able to submit their applications within
the last date on account of aforesaid reasons or for any other
reason beyond the control of SBI.

XI.

XIl.

XIII.

XIV.

XV.

XVI.

XVII.

XVIII.

DECISIONS OF BANK IN ALL MATTERS REGARDING
ELIGIBILITY, CONDUCT OF INTERVIEW, OTHER TESTS
AND SELECTION WOULD BE FINAL AND BINDING ON ALL
CANDIDATES. NO REPRESENTATION OR
CORRESPONDENCE WILL BE ENTERTAINED BY THE BANK
IN THIS REGARD.

The applicant shall be liable for civil/ criminal consequences in
case the information submitted in his/ her application are found
to be false at a later stage.

Merely satisfying the eligibility norms does not entitle a candidate
to be called for interview. Bank reserves the right to call only the
requisite number of candidates for the interview after preliminary
screening/  short-listing with reference to candidate’s
gualification, suitability, experience etc.

In case of multiple application, only the last valid (completed)
application will be retained and the application fee/ intimation
charge paid for other registration will stand forfeited. Multiple
appearance by a candidate for a single post in interview will be
summarily rejected/ candidature cancelled.

Any legal proceedings in respect of any matter of claim or
dispute arising out of this advertisement and/ or an application in
response thereto can be instituted only in Mumbai and Courts/
Tribunals/ Forums at Mumbai only shall have sole and exclusive
jurisdiction to try any cause/ dispute.

Outstation candidates, who may be called for interview after
short-listing will be reimbursed the cost of travelling by Railway-
AC three tier (Mail or Express only) for the shortest route in
India OR the actual travel cost in India (whichever is lower) on
the basis of actual journey. Local transportation will not be
reimbursed. A candidate, if found ineligible for the post will not
be permitted to appear for the interview and will not be
reimbursed any fare.

BANK RESERVES RIGHT TO CANCEL THE RECRUITMENT
PROCESS ENTIRELY AT ANY STAGE.

At the time of interview, the candidate will be required to
provide details regarding criminal cases pending against
him/her, if any. The Bank may also conduct independent
verification, inter alia, including verification of Police
Records,etc. The Bank reserves the right to deny the
appointment depending upon such disclosure and/or
independent verification.

For any query, please write to us through link “CONTACT US/ Post Your Query” which is available on Bank’s website (URL -

https://bank.sbi/web/careers OR https://sbi.co.in/web/careers)

The Bank is not liable for printing errors, if any.

Mumbai
27.05.2022

GENERAL MANAGER
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